
CodeFinder Tutorial (August 2000 revision)
by Roy A. Reinhold

Notice: The content of this Tutorial was selected solely by Roy A. Reinhold to
benefit all who want it. Please send any positive comments or complaints directly
to Roy at:  codes@ad2004.com

The Tutorial was created to help teach you all you need to learn to go from a beginner status to
achieving an intermediate level of skill as a Bible codes explorer, in a very short amount of time.

The Guide to the Hebrew Letters shows you the letter, its name, pronunciation, and computer
keyboard position. The Transliteration Guide provides a means to transliterate names of people and
places, something that everyone is interested in, but which often has been a stumbling block. The
Learning Enough Hebrew to Get By article provides an easy method to learn the Hebrew letters,
it’s really not hard. The new Vowelization Guide is a reference for vowelization marks used in the
Hebrew Tanakh. The Preparing a Matrix and Report for the Web section, explains how to make
them a GIF, and gives info on a couple of shareware GIF programs. Lessons 1-3 teach you a step-
by-step method to apply in using all the functions of the CodeFinder software program.

Hint: When you are reading this Tutorial in Adobe Acrobat Reader, press the button to the left
of the binoculars button to make the display use the entire screen width, it’s easier to read.

TUTORIAL INDEX

1. click here to go to the     Guide to the Hebrew Letters   

2. click here to go to the     Hebrew Transliteration Guide   

3. click here to go to     Learning Just Enough Hebrew to Get By   

4. click here to go to     Hebrew Vowelization Marks Guide

5. click here to go to     Preparing the Matrix and Report for the Web   

6. click here to go to     Lesson 1    (do this before Lessons 2 & 3)

7. click here to go to     Lesson 2   

8. click here to go to     Lesson 3   

Simple Bible Code Search Procedure in CodeFinder
1. launch program
2. load a text to search
3. enter an ELS range to search
4. enter the search terms with the bilingual dictionary, onscreen keyboard, or computer keyboard
5. hit the Search button to begin the search
6. go to Search Results to examine tree of results
7. analyze the results



Guide to Hebrew Letters (August 2000 revision)
by Roy A. Reinhold

Hebrew Aleph-Bet and Letter as Numbers
Letter Name in Hebrew Keyboard Letter Pronunciation Number Value
aleph or alef à T    ah   -lef 1

bet (& vet) á C bet 2

gimel or gimmel â D    gee   -mel 3

dalet ã S    dah   -let 4

hey or heh ä V hey like say 5

vav å U vahv 6

zayin æ Z    zah   -yeen 7

chet or khet ç J khet 8

tet è Y tet 9

yud or yod é H yood like
wood

10

kaf ë F kahf 20

lamed ì K    lah   -med 30

mem î N mem 40

nun ð B noon 50

samech or samekh ñ X    sah   -mekh 60

ayin ò G    ah   -yeen 70

pey or peh (& fey) ô P pey like hay 80

tzadi or tsadi ö M    tzah   -dee 90

quf or kuf ÷ E koof like
roof

100

resh ø R resh 200

shin ù A sheen 300

tav ú , (comma) tahv 400

kaf sofit ê L kahf    so   -feet

mem sofit í O mem    so   -feet

nun sofit ï I noon    so   -feet

fey sofit ó ; (semi-colon) fey    so   -feet



tzadi sofit õ . (period)    tzah   -dee
   so   -feet

NOTE: the above English keyboard letter for the Hebrew letters are for the standard Hebrew
keyboard. There are Hebrew fonts floating around that are non-standard (mostly on Macs). In
pronunciation with words with two syllables, the underlined portion is emphasized. The letter “pey
or fey” is always “fey sofit” when at the end of a word, the “f” sound.

The sofit letters sound the same as the normal letters, but are used when they are the last letter in a
word. For Bible code purposes. the regular letter and final letter are fully equivalent. In other
words, in the code, a nun sofit could appear in the middle of a valid term and the regular letter nun
could be at the end of a word. To recognize the sofit letters, on four of them, the vertical stem
extends below all the other letters.

If the Hebrew letters only go to 400, how can one look for higher number in the Bible code, like
the year 1998 (5758)?

For numbers over 1000, use the thousands letter as a digit. For example, 1561 would start out
with “aleph” which is 1. If the number were 3561, then the first letter would be “gimel”, which is
the 3.

Examples:
25 is kaf hey   (20 + 5)    äë
134 is quf lamed dalet  (100 + 30 + 4)   ãì÷
550 is tav quf nun   (400 + 100 + 50)    ð÷ú
998 is tav tav quf tzadi chet   (400 + 400 + 100 + 90 + 8)    çö÷úú

Note that the higher numbers go first in all instances. There are two special cases which
are avoided in normal use. For 15 use (9 + 6) instead of the normal (10 + 5), tet vav, åè. For 16

use (9 + 7) instead of (10 + 6), tet zayin, æè. These special case substitutes avoid use of part

God’s personal memorial name (yud hey vav hey, äåäé) which is one of the 10
commandments, “to not utter the name of the Lord in vain, or write it casually.”

The year 1998 was 5758 in the Hebrew calendar (at least the first 9 months until Rosh Hashanah).
5758 was hey tav shin nun chet    (5,  400 + 300 + 50 + 8)  çðùúä

A correction is applied to the Gregorian year number so that the letters are the same as in the
Hebrew calendar year, less the 5000 letter (hey). The current correction is 1240 used from the mid
1800’s to sometime in the 2000’s. The correction is subtracted from the Gregorian calendar
number. (1998-1240=758). For the Bible code, we would write 1998 as:

1998 is corrected to 758 and is tav shin nun chet   (400 + 300 + 50 + 8)    çðùú

Compare the letters for 5758 to those for 1998 and to see that they are the same (less the hey for
5000);  tav shin nun chet çðùú

Special case:



alpayeem is “2000s” and shnat alpayeem means “calendar year 2000.” íééôìà-úðù

There is one occurrence of the term “shnat alpayeem” in the Torah, which may show the events of
Gregorian year 2000. The word for 1000s is alafeem. íéôìà

    Adding Leading Consonants (prepositions) on Hebrew Words   
       In Hebrew, you can add leading consonants as a prefix to a word to expand its meaning. The
following are some the Hebrew prepositions:
               letter       pronunciation      meaning    

.....ì        (le)                  to, to a, for, for a (unto), towards

..... á       (be)                 in, at, in a, at a, by, with

..... ì       (la)                  to the, for the

..... á       (ba)                 in the, at the

..... ë       (khe)               as, like, about

..... å       (ve)                  and

..... ä       (ha)                 the

..... ù       (she)                that, which, who (not a question), in order to

..... î       (mee or me)     from, out of

..... ùë    (kshe)             when (not a question)

One example will help you understand what I mean by use of prepositions. The word for Messiah
is mashiach ( çéùî ). If we add hey at the beginning of Messiah, hamashaich, çéùî ä, it
now means “the Messiah”. Codes researchers ought to use the prepositions to extract longer words
and phrases from the Bible code.

click here to Return to Tutorial Index Page



Transliteration Guide (August 2000 revision)
by Morris Shak and Roy A. Reinhold

One of the more difficult areas in Bible code research is in the area of transliterating names of
people and places. Most people have little trouble with translation of words, because a printed
bilingual dictionary or the one included with the CodeFinder software program makes it very easy.
For example, we look up the word “love” in the dictionary and quickly see that the Hebrew word
is “ahavah”  äáäà

However, the purpose of transliteration is to make a name sound the same in
Hebrew as it sounds in English. We are not concerned with the meaning of the name, only
that it sounds the same. Transliterations are used for first and last names of people, and names of
cities, states, and countries. The problem arises in the transliteration process because Hebrew has
22 letters while English has 26 letters. Also, Hebrew has 5 vowel sounds while English has 5
vowels, but each vowel in English can also have long and short vowel sounds, and even some
special case sounds. The result is that when transliterating names, we can sometimes come up with
two, three, or more possibilities. In those cases, the best you can do is look for all possible
transliterations in the Bible code.

The table below is a proposed guideline to help the new Bible code researcher in transliterating
names. It is not to be considered the absolute rule to follow, but will cover most cases. A full
explanation for use of vowels has been added after the table below. Read Hebrew right to left.

    English letter    example    sound     Hebrew equivalent
short A bat ah assumed, or  à  or ò
long A Kate a éà    or   éé
B best b á
soft C city s ñ  or   ù
hard C carry k ÷  or  ë
soft CH cherry short sh ù  or  ö
hard CH christmas kh ç   or  ë
D Daniel d ã
short E bet e assumed, or à or ò
long E mete ee é
special E fern, bird,burn u å
F Fred f ô
soft G gem hard j â  or éâ   or  é
hard G gold g â
H Harry h ä sometimes  ç
short I bit i é
long I bite I éé  or  é



special I bird, fern, burn u å
soft J jahvol (German) y é
hard J Jack j â  or éâ   or é
K Karen k ë  or  ÷
L large l ì
M Maurice m î
N Nathaniel n ð
short O Dot ah assumed or à  or ò
long O Roland o å
double O boot u å
P Perry p ô
Q Qatar k ÷
QU Quentin kw åå÷  or  å÷
R Roy r ø
S Samuel s ñ  or sometimes  ù
special S his z æ
special S visual z æ
SH Shannon long sh ù
T Terence t è  or  ú
TH Thomas t ú
TH they th ú
short U Dunkirk uh (ah) assumed, or  à  or  ò
long U Buford u or oo å
special U burn, bird, fern u å
V Victor v å  or  á
W Washington w åå or sometimes  å
X axe ks ñ÷  or  ñë
special X exact gz æâ
Y yellow y é
vowel Y silly ee é
Z Zachary z æ



diphthongs

ai wait ah+ee=a éà   or éò  or  é
au caught ah + oo åà    or åò  or  å
ay tray long a éà    or éò  or  é
ea heat ee é
ee beet ee é
ei weigh eh+ee=a éé or éà  or éò
other ei Einstein I éé  or é
eo theocracy eh+ah assumed + à  or  ò
eu Deuteronomy eh+oo å  or åà    or åò
ey grey long a éà    or éò or é
ia giant I + ah òé  or àé
ie Brien I + eh àé   or òé
oa boat long o å
oi oil o+ee éå
oo boot oo or u å
ou bought ah+oo å
oy boy o+ee éå
ui intuit oo+i éå
uo buoy oo+ee éå
uo duopoly oo+ah òå or àå  or äå
uy buy I é or  éé
words ending in
ah

Hannah, Sara ah ä  or à    or ò

Hebrew only has 5 basic vowel sounds: ah, eh, o (long o), oo, ee. Actually, aleph and ayin
( à  and ò ) always indicate a vowel sound. Technically they are not vowels as in English, but
are called stops. A stop indicates that a vowel sound should be pronounced. The above table
indicates letter usage when a vowel sound is in the middle of a word, but is misleading to people
when you have a leading vowel sound or ending vowel sound. We are expanding this
Transliteration Guide in order to explain more fully the special cases. This will help you do better
transliterations. Although I am just covering the transliterations of names here in our examples, the
same rules hold true for transliterating the names of countries, states, etc.

    Leading Vowels   



   Internally in a transliterated name, we use the vav ( å  ) for the long “o” or the long “u” (oo)

sound. Likewise, we use the yud ( é  ) internally in a transliterated name for the long “e”  (ee)
sound. The mistakes, I’ve seen people make, are in transliterating a name like “Omar”, when they
begin the transliterated name with a vav ( å  ) for the long “o”. The truth is that if you start a

transliterated name off with a vav or yud ( å  or é ), they are used as consonants and not vowels.
You need to start a name that begins with a vowel sound with a stop. The stop tells
you that a vowel sound is pronounced. The stop is either an aleph or an ayin ( à  or ò ). If the

stop is not modified with a vav or a yud ( å  or é ), then it is the “ah” or “eh” sound. Examples
are Amanda, Edgar, Oscar, etc. (note: some people will want to use a long O in Oscar, you can try
it, but the normal English pronunciation is a short O sound). If the name starts of with a long “o”
or long “u” (oo), then the stop is modified with a vav ( å  ). Examples are Oakley, Olga, Uri, etc.

If a name starts with a long “e” sound, then the stop is modified with a yud ( é  ). Examples are
Edie, Edith. The final case for a leading vowel sound are those names that begin with a long “I”
sound like Eileen or Ida. You can either use a stop plus a single yud, or a stop plus a double yud (

éà , éò, ééà  , ééò  ). Here are the transliterated spellings for our examples (some
have more spelling possibilities than shown).

Omar   øîåà     øîåò
Amanda  äãðîà  àãðîà     äãðîò  àãðîò
Edgar   øâãà    øâãò
Oscar   ø÷ñà    ø÷ñò
Oakley   éì÷åà    éì÷åò
Olga   äâìåà    àâìåò    òâìåà
Uri   éøåà    éøåò
Edie   éãéà    éãéò
Edith   úéãéà     úéãéò
Eileen ïé ìéà  ïéìéò  ïé ìééà  ïéìéò (last letter is nunsofit,  use nun ð)

Ida   äãéà àãéò äãééà àãééò

    Vowels in the Middle of a Name   
        Almost all the time, the ah (a) or eh (short e) sounds in the middle of a word in Hebrew is
assumed. That means that you do not use a stop for the ah or eh vowel sounds when transliterating
a name. Examples are Hannah and Ben. The long o and oo sounds are shown using the vav [å ]
when they in the middle of a word. Examples are Roland and Ruth. The ee sound (long e) is done
using a yud [é ], and an example is Peter. No stop is required in the middle of a name when using
a vav or a yud, the stop is assumed. A long “I” in the middle of a name is done using an assumed
stop plus a single yud or a double yud [ é  or  éé ], and examples are Dianne and Michael. The
name Diane or Brian brings up another point, which is that you have to use a stop after the yud for
the “I” in order to tell readers that both vowels internally in the name need to be pronounced. Here
are the transliterated spellings for our examples (some have more spelling possibilities than
shown).



Hannah äðä  àðä  äðç  (spelled with a chet, is the biblical spelling)

Ben   ïá or with regular nun instead of nunsofit  ðá
Roland  ãðìåø
Ruth  úåø
Peter  øèéô   øúéô
Dianne  ïàéã   ïòéã  both have a nunsofit on the end as shown

Michael  ìàëéî  (biblical)  ì÷éî  ìëééî
Diane ïàéã  ïòéã
Brian  ïàéøá ïòéøá  ïàééøá

Below are a few more examples of names

Ann--  ïà ïò
Charles--  ñìøù ñìøàù ñìøö
Harold--  ãìåøä
Roy--  éåø
Douglas--  ñìâàã ñìâòã  ñìâã
Jackie--  é÷é éëé é÷â éëâ
George--  âøåâ

Notice that the A in Ann can be either an aleph or an ayin. With the name Charles, there are
two things to notice. One is that the “e” is assumed, so there is no letter there for “e” in Hebrew.
Secondly, the “a” in Charles can either be there or assumed, and if we place a letter for the “a” in
Charles, it is an aleph or an ayin. Sometimes the tzadi is used for the soft ch sound.

Harold is a good example of using the sound instead of a letter. When we say Harold, the a
sounds like an e, so we assume it in Hebrew and place no letter for the a. Douglas has a dipthong
“ou” but the name is pronounced like the “ou” is “uh”. It is not used like in “through”. I just
wanted to point this out, because English is much more difficult than Hebrew. We use a lot of
nonstandard sounds for vowels in English, whereas in Hebrew there are just those 5 vowel
sounds.

    Vowels Sounds at the End of a Name   
There are a few special cases to be applied when a name ends with a vowel sound, like Sara.

One is the letter hey  [ ä ], which if used at the end of a word is “ah” and not just “h”. The same is
true of chet  [ ç ], which if used at the end of a word is “akh” and not just “kh”. Finally, if kaf-
sofit  [ ê ] is used at the end of a word, it can sometimes be “kha or ka” rather than just “kh or k”.
an example is “kamokha” ( êåîë  which means “like yourself”).

Where a vowel sound is used at the end of a name, it requires a stop (aleph or ayin, à ò ) or
a hey ä  (if the name ends in the “ah” sound), except for the special cases where a word ends in
kaf-sofit. Aleph at the end of a name can be either “ah” or short “e”; while by convention ayin is
only the “ah” sound and not a short “e”. Some examples of names ending in vowels follow:

Canada  äãð÷
Sarai (Abraham’s wife)  éøù



Sarah  äøù äøñ àøù àøñ òøñ òøù
Sara äøù äøñ àøù àøñ òøñ òøù
Penny   éðô
Moldavia  àéáãìåî òéáãìåî àéåãìåî
Hutu  åèåä åúåä
Bobo  åáåá

    Biblical Hebrew versus Modern Hebrew by Morris   
One of the many arguments among early codes researchers was the use of biblical Hebrew

over modern Hebrew. Modern Hebrew is more standardized, following a stricter set of rules. In
biblical Hebrew, many times the long O sound didn’t use a vav, as in the name Moses (actually
pronounced Moshe in the Bible, äùî ). Research has now leaned toward using the more stricter
modern Hebrew usage, which leaves less wiggle room on spellings.

There are many examples where the same word is spelled in more than one way, in the Bible
and sometimes in modern Hebrew too. In the Bible, at some places one may find a word spelled
with a yud and at other places the same word without the yud. The same holds true for use of the
vav in the Bible, sometimes with a vav, and the same word in other places without. Since we are in
the early learning stages in knowledge of the Bible code, one ought to know that there are more
variables to look at, if one considers the possibility of spelling variations according to the biblical
model.

What is the right answer for the purpose of Bible code research? One must try to look for both
versions for each occurrence of the word. For example, the name Morris is typically spelled with a
vav in all Hebrew print (for the O sound). I was surprised to find Morris in my matrix spelled
without a vav, and there are several factors that indicated that this is no coincidence. (There was
even a sentence at an ELS of 16 saying, “borrowed a foreign name”, the year, month and day it
was done, etc.)

     What Name Do I Look For? by Morris   
How many ways can a person’s name appear in the matrix? It can appear in several ways for

each of the following categories:  FirstName, NickName, FirstNameL (L is the first letter of the
last name), FirstNameI (initial of middle name), LastName, Acronym, and FirstNameLastName,
etc. There is also a unique version for a two-word name. Look for both names, one on the row
immediately above the other, and both have the same ELS. They could also be crossing or closely
parallel.

When preparing a matrix for a specific person, where the correct version of the name in
Hebrew is known, start by using full Hebrew name(s) to establish the matrix. When doing a
matrix on historical persons, remember that many well known people changed their names (just as
many modern actors have both a stage name and their real name). You might have to do some
research and find out the historical figure’s birth name. Then look for their birth name and more-
well-known-later-name.

In this January 2000 revision of the Transliteration guide, we have endeavored to greatly
expand the information on special case uses for vowels at the beginning of a name, in the middle of
a name, or at the end of a name. Hopefully, you will benefit from these changes to the
Transliteration Guide.

If you are new to the Bible codes, it should not be too hard for you to learn enough Hebrew to
get by. What is required is that you memorize the 22 Hebrew letters and learn the vowel sounds.
Take a look at the page in this tutorial on Learning Just Enough Hebrew to Get By. You don’t need
to learn to speak Hebrew well in order to do credible Bible codes work. You’ll learn a lot of
Hebrew as you are working on the Bible code (provided you memorize the letters as a start, so that
they don’t look like strange symbols to you anymore).



click here to Return to Tutorial Index Page

click here to Go to Learning Just Enough Hebrew to Get By Page



Learning Just Enough Hebrew to Get By
(August 2000 revision) by Roy A. Reinhold

Everyone starts out in the Bible codes by getting enthused about all the amazing discoveries in
the Hebrew Bible code. They look around and buy a codes software program, and then are
confronted with a lot of expectations which seem daunting. Actually, when you start out, you are
really learning in 3 distinct new  areas, and the codes software program only provides one of the 3
pieces. The 3 areas you need to learn are:

1. Bible codes theory-- this includes all the terms like equidistant letter spacing (ELS), search
terms, vertical terms, matrix ELS, term ELS, Torah, Tanach, etc. It includes knowledge of what a
matrix is and what it is not, and some knowledge of what others have proven in the Bible code.

2. Bible codes software programs-- in the last 3 years Bible code software programs have
greatly advanced and are a 1000 times faster, more capable, and easier to use. However, you still
need to learn the functions of the program in order to use it. Bilingual dictionaries, onscreen
Hebrew keyboards, automatic matrix determination, multi-dimensional row-splitting, and more
functions are applications of the latest research discoveries in the Bible code. In CodeFinder, the
HELP is built as an online manual to show you graphically, and explain the functions of the
program. You need to put it all together to be able to do good codes searches. This Tutorial is a
means to teach you a methodology to do intermediate level codes searches.

3. The Hebrew Language-- the Hebrew letters seem like a large stumbling block to new users
unfamiliar with Hebrew. The fact is, you do not need to take a class in Hebrew, or learn to speak
Hebrew in order to do credible codes research. What you do need to learn are the Hebrew letters.
Hebrew is easier than English, and is entirely phonetic, therefore, once you know the Hebrew
letters, Bible codes searches become much easier.

Just how much Hebrew do you need to learn to get by in Bible codes research? The answer is
that you need to memorize the 22 letters of the Hebrew alphabet (actually  aleph-bet), and also the 5
end letters. The 5 end letters are variations in shape when these five letters are used at the end of a
word (kind of like the way we use capital letters in English).

Here is the secret to advancing rapidly in doing Bible code searches. You
need to memorize the Hebrew letters just as a first grader would, through rote
memorization. No, you don’t need to go out and buy a Hebrew training software program or
book. I have helped many people get started in the Bible code in the right way and I make the
following claim from experience, “You can learn the Hebrew letters in 2-7 days.”

In order to use rote memorization of the Hebrew letters, you need to humble yourself to being
a first grader for a week. Teachers of first graders stand in front of the class and point at letters as
the class repeats them. They do this every day until the class can say all the letters of the English
alphabet. Then they do them in a mixed up way to ensure that the class knows each letter when
they are not in order. You will do the same thing with the Hebrew letters, except that you won’t
have a teacher with a pointer pointing to them and asking you the name of the letter.

Get 27 3x5 index cards, with or without lines on them. Then put the Hebrew
letter on one side written in large size, and on the reverse side put the name of the
letter. You are creating a set of home-made flash cards at little or no cost (no cost if you already
have some index cards, a little cost if you have to buy some). Make a card for each of the 22
Hebrew letters and a separate card for each of the 5 end letters, so you’ll have a total of 27 flash
cards. When making up the flash cards, make sure you recognize the difference between letters that
look closely like another letter. These are:
resh and dalet and kaf sofit--  ø ã ê



The top part of the resh curves around from the vertical stem.[ ø ] While in dalet the top is abruptly
perpendicular to the vertical stem, and most of the time the top horizontal portion extends to the
right of the vertical stem a little ways. [ ã ] Kaf sofit has a longer vertical stem [ ê  ].

vav and nun sofit and zayin--  å ï æ
The vav and nun sofit are very close except that nun sofit has a longer vertical stem. The top part of
the zayin extends on both sides of the vertical stem.
hey and chet and tav--  ä ç ú
The hey is open on the left side, while chet is like a square n. Tav has a hook in the lower left.
samech and mem sofit and mem--  ñ í î
The samech is rounded, while the mem sofit is square. Mem has an opening on the bottom.
ayin and tzadi and tzadi sofit--  ò ö õ
The ayin has a tail that slants left, while the tzadi goes either in the opposite direction then hooks to
a horizontal bottom, or it goes straight down from the y and then hooks to a horizontal bottom. The
tzadi sofit end letter has a longer vertical stem and goes straight down from the y.
bet and kaf--  á ë
The bet usually has a heavy, double thickness horizontal bottom [ á ], while the kaf is like a
squared backwards c and is rounded [ ë ].

To make up your set of flash cards, go the Guide to the Hebrew Letters in this Tutorial, where
the letters are all shown with their names. Learn them in the correct order first, then mix them up
and practice with your flash cards a few minutes throughout the day. Repetition and saying them
out loud helps.

click here to go to Guide to Hebrew Letters

click here to go to Tutorial Index Page

You’ll be surprised how quickly you can memorize the Hebrew letters. The next surprise is that
you’ll immediately be able to read Hebrew, because you already know how to read, and can
phonetically pronounce the letters in Hebrew. You will have to learn the “nikud”, those strange
vowel markings around the letters in the printed Torah and Tanach text. However, the nikud are
easy too.



The Hebrew Vowelization Marks Guide (nikud)
(August 2000 revision) by Roy A. Reinhold

The vowelization marks in the Hebrew masoretic text of the Torah and Tanakh were invented
by the masoretes in Tiberias. They applied the nikud (vowelization marks) to the text of the Tanakh
in the 7th to 8th centuries AD. From history, you may remember that the Romans defeated the
rebellious inhabitants of Israel in 70 AD and burned the Temple. Another rebellion took place in
135 AD,  called the Bar Kochba rebellion, and after thoroughly defeating the Jewish people, most
were either taken as slaves or dispersed throughout the known world of the time.

The masoretes (traditionalists) in Tiberias along with those in Jerusalem and Babylon,
undertook a project to salvage Jewish identity and knowledge of the scriptures. The nikud enabled
Jewish people anywhere in the world, the knowledge to properly pronounce biblical Hebrew, at a
time when Hebrew was a second or third language to most dispersed Jews, if they knew it at all.

Is knowledge of the nikud necessary to do good Bible codes research? No, not really, since
you do not need to be able to read the Hebrew Tanakh well in order to do Bible codes research.
However, since I point out in this tutorial that knowing the Hebrew letters IS NECESSARY in
order to get far in the Bible codes, in the section titled, Learning Just Enough Hebrew To Get By, I
thought it would be good to have a reference on the vowelization marks. That way you have
enough knowledge when viewing the Hebrew Tanakh, to be able to read it as well as anyone.

A short review of vowels is relevant here. There are only 5 basic vowel
sounds in Hebrew: short “a” as in “aha”, short “e” as in “bed”, long “e” as in
“beet”, long “o” as in “vote”, and long “u” or “oo” sound as in “boot”.

The information is taken from the Oxford English-Hebrew Dictionary (1996 edition, pg ix).
Therefore, if you have any problem with the information, take it up with the experts in Hebrew at
Oxford.

What is important to remember with regards to the vowelization marks, is the vowel sound
itself associated with the symbol, and not necessarily the name of the symbol. In pronunciation of
the name of the symbol, the standard accepted usage is that an “a” is a short a sound, an “e” is a
short e sound, an “i” is the long e sound, an “o” is the long o sound, and a “u” is the “oo” sound.
Also, the “ch” is a hard ch as in christmas, the “kh” sound. All vowels are pronounced, so that the
Male in Cholam Male, is ma’le.

NAME SYMBOL Approximate Phonetic Value
Kamatz t= a as in aha!

Chataf Kamats t8 o as in corn.

Patach t- a as in aha!; when under a final c  or  i, a smooth
breathing is pronounced before the consonant
(-ach, a).

Chataf Patach t7 a as in aha! or a little like a shewa.

Tseire t2 e as in bed.

Segol t3 e as in bed.



Chataf Segol t6 e as in bed.

Chirik t1 ee as in tee.

Cholam Ot o as in corn.

Cholam Male o o as in corn.

Kamats Katan t= o as in corn.

Shuruk V u as in put.

Kubuts t5 u as in put.

Shva t4 shewa, a kind of grace sound, where a consonant
has no vowel force (sound).

Dagesh stress mark in the center of a letter. Also changes
kaf to haf, bet to vet, and pey to fey.

Important note: the Hebrew font I was using to prepare this page, did not have a
dagesh key, so I used another font to show the dagesh symbol, which shows
poorly. The dagesh symbol is a single dot in the center of the letter. I apologize
for this shortcoming. Also, the Kamatz and Kamats Katan look the same, but the
Kamats Katan is usually smaller, again, there was no way to show this because
the font did not have the key.

You really can learn to read the Hebrew Torah and Tanakh correctly by knowing the nikud
(vowelization) marks above. In normal Hebrew in Israel, you will not see the vowelization marks.
It’s only done for children’s books to teach them, in the Torah and Tanakh, and in Hebrew prayer
books.

click here to go to Tutorial Index Page



Preparing a Matrix and Report Legend for the Web
(August 2000 revision) by Roy A. Reinhold

CodeFinder has some very powerful built-in functions to help you save a matrix or matrix
report with very little effort. The aim of this section is to give you some hints in preparing the
Matrix or Report for display on the web, and perhaps to save some space on your hard drive.

1. Matrix -- CodeFinder makes it very easy to save your matrix as a graphics file. When you are
done working on the matrix, select Cropped Matrix and a new window opens cropping the matrix
to the size of the boundary box in the Matrix View (that dotted line, colored box in the matrix). In
the lower right panel of the CodeFinder main screen, it shows how many rows and columns are in
your cropped matrix.

Next, select File--Save Matrix and name it “xxxxx.bmp” which saves it as a graphics
bitmapped file. You could create another folder in CodeFinder named graphics, so that your saved
graphics files are separate from the Exported Search Results and Exported Search Lists in the
Exports folder; it’s just good file management.

I am willing to put matrixes up on the Codes in the Bible website by request, and give
attribution to the creator. However, the BMP file is too large to send over the web. For example, if
you do Lesson 2 in this tutorial and create a matrix on Ehud Barak and save it as a .bmp file, it’s
1.5 Mb in size. That’s huge.

Should you open the BMP file of the matrix in a graphics program and save it as a JPEG,
PNG or GIF? If you save it as a JPEG, the letters will look fuzzy due to the dithering and loss of
detail. Yes, a JPEG will be much smaller in size than a BMP file, but the loss of detail in JPEG
makes it look terrible. JPEGs are good for photographs, not for Bible code matrixes. You need
a graphics program in which you can save the BMP file as a GIF or PNG. The 1.5
Mb matrix of Ehud Barak from Lesson 2, when later saved as a GIF, is only 26.8 kb in size, and
the 26.8 kb GIF matrix looks just as sharp in detail as the 1.5 Mb BMP file. That’s a reduction in
size of 1/56, when you transform the matrix from BMP to a GIF.
       PNG is a relatively new compression format created by Microsoft. It is a free compression
format and is displayed only in version 4 and 5 of both MS Internet Explorer and Netscape
Navigator browsers. People who have old browsers or a browser  other than Navigator or Internet
Explorer may not be able to view a PNG graphic. PNG graphics are compressed to about the same
size as a GIF and there is no loss to dithering like with a JPG graphic. Since the vast majority of
people browse the web with the newer Navigator or Internet Explorer browsers, PNG graphics are
now a good viable option to use (or use GIF which everyone can view).

I personally use Paint Shop Pro 5.1 from JASC to do the graphics preparation. However, it’s
a premium program that sells for about $100. You can get a couple of shareware programs for very
little cost, that will do the trick, or a freeware program for free. One CodeFinder owner reports that
you can buy the Paint Shop PRO program at a discount at the Amazon.com software section. It’s a
premium program with 90% of the tools of Adobe Photoshop at 1/6 the price, while the following
three programs are toys in comparison. Try the freeware program which allows you to save a BMP
file as a GIF or PNG graphic. I’ve tried it and it works fine and is free. Two shareware programs
that I’ve downloaded and tried out are SuperClip, and BMPToGIF Pro. I have no association with
these two programs, but am only recommending them for someone who doesn’t have a graphics
program. If you already have a graphics program that will save a file as a GIF, then ignore the
following advice.
       BMPtoGIF is a freeware program which means it is free to use and doesn’t time out. It is a
small, simple program that allows you to open a BMP file and save it as either a GIF or PNG file
which reduces the size to less than 1/50 the size without loss of detail. Download BMPtoGIF
freeware at:   http://www.develcor.com/utilities/bmptogif.htm. This will enable you to
transform the large matrix BMP file to a small GIF or PNG file. For the matrix report in
CodeFinder, first save it as an RTF file; then open it in a word processing program and modify it
as desired. Next press your “Print Screen” key on your keyboard to save the report as a bitmapped
file to the clipboard. Open your Windows Paint program that comes with Windows and select



EDIT--PASTE in the menus. It will paste the matrix report as a BMP file. Trim it to size and save
as a BMP file. Next start your free BMPtoGIF program, open the BMP file you just saved in
Paint, and save it as a GIF or PNG. It’s easy and this process uses all free programs.

SuperClip comes as a shareware version that you can download for a free trial at:
http://www.androsoft-usa.com            It allows you do open a BMP file like your saved
matrix in SuperClip, and Save As a GIF file. It also enables you to use “Print Screen”, then trim
the display, and save as a GIF, all in seconds. The program also has many other features. If you
wanted to register the shareware and get the Professional Edition of SuperClip, it’s $39, which is
fairly steep. After 1 week it times out and puts SuperClip on saved images. For that reason, I
recommend the less expensive BMPToGIF Pro below for only $20 registration.

BMPToGIF Pro is an easy to use program that enables you to transform your matrix BMP
file to a GIF or PNG in 2 steps. It couldn’t possibly be any easier. You can download the
BMPToGIF Pro program at:    http://www.develcor.com/utilities/bmptogifpro.htm
The program allows you to open a BMP file and select Save As to save it as a GIF, PNG or a
number of other formats. It also allows you to paste from your clipboard, as when you use Print
Screen. The program times out 7 days after you download it, but the cost to register is only
$19.95. Try the free BMPtoGIF program before deciding whether you want their PRO version.

For those of you who don’t know, the compression algorithm for GIF is a patented process
owned by Unisys. Therefore, the GIF compression could not be built directly into CodeFinder
without getting permission from Unisys and paying them royalties.

2. Report -- The matrix Report function in CodeFinder enables you to create a full report of all
terms in your matrix, done by selecting View--Report. It shows each term in the matrix in Hebrew
in the marked color of that term in the matrix, in English, the ELS of the term, the text R-value, the
matrix R-value, and the beginning and ending of the term by book-chapter-verse information. You
can window between the Matrix View and Report by selecting them under the Window menu. The
Report can be printed by selecting File--Print Report. You can also save the Report in either a
tabbed text or RTF formats by selecting File--Save Report. The tabbed text format allows you to
then open the report in a spreadsheet program or word processing program that accepts tables (like
MS Word, MS Works, Wordperfect, etc.). RTF format allows you to open the saved file in any
word processing program including Wordpad, to further prepare it for use as a printed matrix
report or more importantly, to prepare it for use as a graphic file legend for the web.

Which is better, to save the Report as a tabbed text file or an RTF file? Personally, the
RTF format is easier and better, because everyone has a word processing program
(Wordpad comes as part of Windows 95/98). Also, the RTF format retains the colors of the
Hebrew terms in the Report, and also retains the Hebrew font display for the
terms. In preparing the Report for use on the web, I would likely leave as is, or perhaps cut out
the ending letter position of the term column. The summary lines at the bottom of the report shows
the Matrix ELS and the beginning and ending of the matrix by book-chapter-verse. When saved as
an RTF file, you can open the Report later in a word processor and cut the unneeded columns,
apply a background color, and save it. With it still onscreen, you can hit the “Print Screen” key on
your keyboard, then open your graphics program and paste from the clipboard as a BMP file. Then
Save As a GIF.

When you use the tabbed text format to save your Report in CodeFinder, it enables you to
later open it as a table in a spreadsheet program or word processing program that accepts tables.
However, because it is a text file, it loses the formatting for the Hebrew in the first column, and
loses the colors for each term. In the spreadsheet, just select the first column and apply the Elronet
mono bold 12pt, or the Netextmo font. You cannot get the colors back except by applying them
individually to each Hebrew term. For that reason the RTF format is much better. However, if all
black letters are OK, then text is not hard to use either. Add a border around the outside of the cells
and a background color, and you have the Report done. Then use the “Print Screen” key to copy it
to your clipboard, and paste it into your graphics program to save as a GIF.

Another method is one that I use because it is faster, but requires a little more knowledge of
graphics. When I have a Report in CodeFinder, instead of saving it, I just make the window as



large as I can, then use “Print Screen” to copy everything to the clipboard. Then I open my Paint
Shop PRO graphics program, paste from the clipboard, and trim off all the excess. Then I add a
border, background color, and save as a GIF. With this method, I can prepare a wonderful GIF of
the matrix Report in a couple of minutes without using a word processing program or spreadsheet.

There is no one answer for preparing the matrix Report as a GIF for the web, since
CodeFinder gives you the latitude to use whatever programs you already have, by saving the report
as a tabbed text file or RTF file. Try the different methods and see which way you like to do it.
What is apparent, is that you can prepare a great matrix legend now without typing, without using
many GIFs for each term, but do it all in one step and have a nice, uniform looking matrix legend
as one GIF that is small in size.

click here to Return to Tutorial Index



Lesson 1:  HOW TO PERFORM A NAME SEARCH IN HEBREW
(August 2000 revision) by Roy A. Reinhold

   This lesson teaches you to do a name search using the CodeFinder program. You can
print this lesson in order to go through the numbered steps on your own program at
home. By going through each step, you will learn how to use CodeFinder applying
both the simple functions and more advanced capabilities. Bible code searches are not
really difficult once you learn how to utilize all the functions of the program.

   Lesson 1 looks for Albert Einstein in the Torah (the first five books of the
Bible). We will look for 4 terms that have already been transliterated. You should
know that transliteration of names of people and places is the most difficult thing to
learn in doing Hebrew code searches. Translations are easy since any bilingual
dictionary will give you the answer, where we look up an English word and the
dictionary gives us the Hebrew equivalent. Transliterations of names of people and
places requires you to use Hebrew letters in order to make the name sound the same
in Hebrew as it does in English. Since there are 22 Hebrew letters and 26 English
letters, and there are Hebrew letter sounds that are not in English and vice versa, it
takes practice and often requires the Bible code researcher to try 2 or more spelling
variations for the same name. Please refer to the lesson on transliterations for more
information. The 4 terms in our search are:

1. Einstein-- we will use  ïééúùðéà

Einstein could also be spelled as: ïééúùðééà ïééèùðéà  ïééèùðééà
note: we could also use samech ñ instead of shin ù, or use ayin ò instead of aleph à.
All these would give the same sounding name in Hebrew. In all, there are 12 possible
spellings. Some experience helps you narrow these possibilities down to a couple.

2. Albert -- there are 4 possibilities for spelling, we will use  úøáìà

the other 3 spelling possibilities are: úøáìò èøáìà èøáìò

3. scientist-- mad’an  ïòãî

4. Theory of Relativity-- yakhasoot  úåñçé

Step 1: Start the CodeFinder program and click on the yellow folder icon at the far
left of the row of buttons. The alternative would be to select File--Open in the menus.
We are searching the Torah, so highlight “torah.cod” and press OPEN. The Torah will
load for search and you can see the progress bar on the bottom of the screen. It only
takes a couple of seconds.



Step 2: Now we go to the Settings window, select Options--Settings and the Settings
window opens. Set columns=85 and rows=85 and wrap=20. Make sure the Lock
Matrix box is checked and the Let Search Wrap box is unchecked. Set Maximum
Match Count=200000, and the Minimum Skip= -15000 and the Maximum Skip=
15000. The minimum skip is set to a minus number in order to search for reverse
occurrences. This setting will look from -1 to -15000 and 1 to 15000. If these settings
didn’t obtain the desired results, you could make the matrix size larger than 85x85
rows and columns, to something like 150 columns and 150 rows. Press OK to store the
results and close the window, if you press cancel it will close the window but keep the
previously stored settings.

Step 3: Next to the Search button, set the Skip: From to -15000 and To, to 15000.

Step 4: Now we are ready to enter the 4 search terms. You can either use the
computer keyboard or the onscreen keyboard. Let’s use the onscreen keyboard. First,
click in the Search Term box to put the cursor there. Then click on the keyboard icon,
which is the 3rd icon from the left. Now we input the Hebrew letters. The first term
entered is very important, because all terms will be matched to it. We will input
Einstein as the main term, the order of the others doesn’t matter. Notice that as you
enter the terms and press the enter key, that the statistical expected occurrences for
each will be shown in the lower right bar of the program. Enter as:

Einstein--type in from right to left--  ïééúùðéà
(computer keyboard “thba,hhi”)

Albert-- type in from right to left--  úøáìà
(computer keyboard “tkcr,”)

scientist-- type in from right to left--  ïòãî
(computer keyboard “nsgi”)

theory of relativity-- type from right to left--   úåñçé
(computer keyboard “hjxu,”)

Just below the terms above, I give you the letters to type using your computer
keyboard and their English letter legends. The top row of the onscreen Hebrew
keyboard corresponds to the top row of letters on your computer keyboard except that
Israeli qwerty does not use the “Q” and “W” keys. Note that the last letter of Einstein
and scientist is a nun sofit, one of 5 Hebrew end letters. All Bible code programs make
the end letter equal to the regular letter, or, nun sofit=nun. When you type the terms
above in CodeFinder, you’ll see the shape of the regular nun [ ð ] and not the nun sofit
[ ï ].



     After typing it, press the enter key and the term will move down to the Search List
pane. Then type the next term.  Note: if you couldn’t see the bottom pane of the
CodeFinder window that displayed the expected occurrences, it means that part of the
window is being obscured by the Windows command bar. If that’s the case you can
hide the Windows command bar by moving the cursor on top the command bar, right
click and select Properties. Check the auto-hide box and click OK. The command bar
will be hidden until you move your cursor to the bottom of the screen. This method
allows you to use the full screen size while still having access to the Windows
command bar.

Step 5: We need to check whether there are too many terms expected, before we
begin the search. Open the Search Parameters window by selecting Options--Search
Parameters. We will go through each term to make sure there aren’t too many finds.
Use the small up arrow button to scroll through terms 1 to 4. While we have term 1
displayed, type in “Einstein” in the Translation pane and delete the dashes there. If we
had used the bilingual dictionary to enter the terms, then the English translation would
already be there. We see that the expected occurrences is low, so use the small up
arrow to go to term 2. Type in “Albert” in the Translation pane, and we note that the
expected occurrences is not too high, so go to term 3. Type in “scientist” in the
Translation pane. We note that the expected occurrences is too high, so we uncheck the
box that says, Use Default Skip Range, and type in Min -5000 and Max 5000. Notice
that as we did this the real-time statistics just below where we are entering the terms
goes down as we lower the ELS search range. When the expected results are over
about 12,000, I generally lower the search range for that term. Use the small up arrow
and check term 4, and type “relativity” in the Translation pane. The expected
occurrences is satisfactory, so press OK to close the Search Parameters window.

Step 6: In the menus, select OPTIONS--RowSplit--and DISABLE to disable the
automatic row-split (we’ll explain it further down). We are now ready to begin the
search. Click on the Search button and watch the progress bar at the bottom and also
the terms will start appearing in the Search Results pane. You should see Einstein (4),
Albert (9532), scientist (9923), and theory of relativity (705). The numbers next to the
terms is the number of matches for each. Of course you are looking at the terms in
Hebrew. If you forget what each one is, you can toggle the Search Results and Search
List to English by moving your cursor to the Search List pane and right clicking.
Right click again to change them back to Hebrew. Another method of toggling the
Search List and Search Results to English or back to Hebrew is to use the menu
selection, Options--View as English. If we hadn’t typed in the translations for each in
the Search Parameters window, then all we would see are about 5 dashes for each.

Step 7: When the search is fully completed, click on the little plus box next to
Einstein, the top term in our search list. This will open the tree, showing information
about each of the 4 finds for Einstein. Widen the area of the pane, to see all the
information in the Search Results, by moving the cursor over to about where the
matrix display area begins. The cursor will change to 2 vertical lines with a right and



left arrow. Press down on the left mouse button and hold it while dragging to the right
so that you can see all the information for each find of Einstein. The top one should
be:  (1) -4061  250936 [2]. The first number to the left in brackets is the sequential
number for the terms. The second number, -4061, is the ELS (equidistant letter
spacing). The third number is the text letter where the first letter of the term is found.
The program numbers the first letter of Genesis as 1 and the last letter of
Deuteronomy as 304,805, when using the Torah as the search text. So we can guess
that 250936 is near the beginning of Deuteronomy or end of Numbers. The last
number [2] in brackets is the number of terms matched to the main term. So we know
that if we displayed this matrix there would be 3 different terms in it, Einstein and two
other terms matched to it. Note that the first 2 finds for Einstein have [2] in brackets,
the 3rd term has [1] in brackets, while the 4th term has no matched terms. You might
guess that term 4 is not too good, and think that you’ll have to examine each of the
first 3 finds to see which looks best. That’s the old way of doing things.
     Version 2.1 of CodeFinder now sorts the occurrences of the main term in the
Search List (top in list) by the number of matches from highest to lowest, after the
search is complete. This enables the user to focus in on those at the top of the list as the
best candidates for further development.

Step 8: The Bible code is not a simple flat 2D plane but is multi-dimensional. Not
many people know about this yet, but you are going to apply this concept I discovered,
using it right from the start. CodeFinder has a function built-in to take advantage of
that capability and seek the optimal matrix view. It’s called row-splitting. Instead of
explaining it, let’s see it in operation. The row-splitting function is under the Options
menu and allows you to select disable (row-split of 1, or no row split), auto, 2, 3, 4, 5,
6, 7, 8, 9, 10, and 11. When you change the setting, the CodeFinder rematches terms
to the new matrix width (determined by dividing the ELS by 1 through 11 as selected).
Use row split to manually go through 2 to 11, one at a time. The program only takes a
couple of seconds to re-match the terms. When you select a row split of 2, you’ll see
that the top term changes where the number in brackets is no longer [2] but is now [3],
at an ELS of -3322. This means you have found the matrix with all 4 terms in it, at the
least possible row-split. Re-select a row-split of two and leave it there. That is the
matrix we will now optimize. Double click on the Einstein term at -3322 ELS at the
top of the list, to display the matrix that has all 4 terms in it.

Step 9: With the matrix displayed, maximize the matrix size by clicking on the center
box in the far upper right corner of the Matrix Display screen. You can also show
more of the matrix by moving the cursor to where the matrix starts on the left side
and when the cursor changes to the 2 vertical lines, left click and hold and drag to the
left, then release the mouse button. You’ll know by using this function a few times,
where you like it best as far as maximizing the displayed matrix versus seeing the
Search Results pane. Now we want to center the matrix by moving the scroll bar on
the bottom and on the right side to the center of the range. What you want to do is
center the vertical word in red letters. Notice that Einstein in red letters is vertical, but
each letter is every other row. This means that although we found the term at an ELS



of -3322, the displayed matrix is optimal at a row split of 2 or an ELS of one-half of
3322=1661. The minus ELS (-3322) tells us that it was a reverse occurrence where the
first letter is at the bottom instead of at the top in the matrix display (in other words,
if you are reading the term, you would read from bottom to top).

A great function in CodeFinder allows you to read the terms in the matrix. Move
your cursor on top of one of the marked letters. Right click and hold down the mouse
button. A cursor tooltip window will open, showing the term in both Hebrew and
English. It also shows an “S” value which is the ELS of the term, and a text “R” value,
which is a statistical calculation to help show whether the term is there by chance or
design.

Step 10: The matrix looks good as is, or you can shut off individual terms displayed
to simplify the matrix. The two occurrences of Albert above Einstein share a tav. The
one immediately below Einstein shares the aleph with Einstein. There are 4
occurrences of Albert under this occurrence of Einstein, and we could turn off the
very top Albert to make the matrix smaller. Open the tree to see the individual finds
of Albert under our Einstein term at ELS of -3322. Then drag on the aleph in Albert
at the very top of the dashed line box in the matrix, and read the letter number. That’s
in the tree of results and tells us which Albert to turn off. The letter number is 870
and the ELS is 3314, turn it off by right clicking on the book for that specific find in
the tree of results. You’ll see two yellow hands cover a sheet of paper to tell us the
term is turned off. Then double-click on the line in the results tree with Einstein to re-
display the matrix. When you turn a term off or on, you won’t see the change in the
matrix until you redisplay it.

Even better, we could also use the cursor tooltip function in CodeFinder by
moving the cursor over a marked letter of a term in the matrix we want to shut off.
Right click and hold down the mouse button to read the term and note the ELS of
3314. Then we can just go into the tree of results under Albert and look for a find
with an ELS of 3314, and right click on its book to turn it off.

We now have a matrix that we have made smaller and simpler, that is saved at only
51 columns and 48 rows (enclosed by the colored box made up of dots in the matrix).
The final matrix has 1 occurrence of Einstein, 3 occurrences of Albert, 5 occurrences
of scientist, and 1 occurrence of theory of relativity.

Step 11: The default font setting in CodeFinder is Netextmo mono 11, and the letters
are thin. This is OK when we are working on the matrix, because using this thin letter
allows us to see more of the matrix onscreen. However, for showing the matrix on the
web, it would be better to make the letters and symbols around the marked words
more prominent. We do this by changing the font setting after the matrix is done.
Select, Options--Font and change the font to Elronet Monospace bold 12 and the
matrix will look much nicer for use on the web.

Step 12: Now we can save the search results, in order to come back later and add in
more terms, or to keep it on file. We’ll use the Export Search Results function to save
the entire search results exactly as you see it onscreen now. In the menu, select File--



Export Search Results and name the file, something like Einstein.srf or whatever
you’d like, and press Save.

Step 13: We can save the matrix as a graphic directly. First we’ll select Cropped
Matrix under the View menu. This will reduce the size of the Matrix View window
and open another matrix window named Cropped Matrix Window. The size of the
cropped matrix is 51 columns by 48 rows, which is the reduced size that was enclosed
within the dotted box in the larger 85x85 matrix. After the Cropped Matrix Window
is onscreen, then select Save Matrix under File to save the matrix as a .BMP
(bitmapped) file. Name it Einstein.bmp or whatever you’d like, and press Save. We
are now done doing a complete matrix search, optimization, exporting the search, and
saving it as a BMP graphic file. If you desired to look for additional terms in the
matrix, then go to step 15 for searches within searches.

Step 14: CodeFinder has a function called Report, that shows all the marked terms in
your matrix. Select it under View--Report, and it builds a Report of the matrix. The
Report includes the Hebrew spelling and color of the marked term in the matrix, the
English translation, the term ELS, the text R-value, the matrix R-value, and the
beginning and ending of the term by book-chapter-verse information. The Report also
includes a summary at the bottom with the matrix ELS (which is different than the
center term ELS when row-split), and the beginning and ending book-chapter-verse
for the matrix. You can window between the Matrix View and Report by selecting
them under the Window menu. You can also print the report under File--Print Report,
or save the Report as a tabbed text file or RTF file, by selecting File--Save Report. I
recommend using RTF to save the Report, since it retains the Hebrew and color of the
terms; then modify it in a word processing program and save as a GIF for display on
the web. Saving the Report as a tabbed text file allows you to open it in a spreadsheet
program or word processor that accepts tables. Read the article in this Tutorial on
“Preparing the Matrix and Report for the Web”, to get further details on making the
Report and Matrix a GIF for the web.

Optional Step 15: To look for additional terms while retaining all the work you’ve
done, just enter new search terms using the bilingual dictionary or by typing in new
terms. Then check Search Parameters to ensure that you don’t get too many finds,
lowering the ELS range for short words that have high numbers of expected results,
add in the English translation for the new terms while you are there, and press the
Search button again. It won’t affect the terms already obtained, but will just look for
the new terms or terms where the parameters are changed, and then do a re-match of
all terms. In the case of this Einstein matrix, we could lower the ELS range for new
terms in Search Parameters to -10000 to 10000 in Search parameters, since we are
using a matrix width of 1661 letters. This limit will ensure that vertical terms found
will be no more than every sixth line, which is about the limit for readable terms in
the matrix.



We have not attached the finished matrix for you to see, because we want you to do it
without seeing the finished result. Go through the steps and do it yourself. I’ve placed
the link to go to the finished matrix and matrix report for Lesson 1 at the bottom of
the webpage  http://ad2004.com/Biblecodes/Hebrewmatrix/Hebmatrix.html
so you can see the finished matrix afterwards, and compare it to your own work. This
way you can compare what you’ve done versus the finished matrix without having seen
it beforehand. After all, when you do a new codes matrix, you don’t have the benefit
of seeing it beforehand.

click here to Return to Tutorial Index



Lesson 2:  HOW TO PERFORM A NAME SEARCH IN HEBREW
(August 2000 revision) by Roy A. Reinhold

   This 2nd lesson teaches you to do a name search using the CodeFinder program, and introduces a
number of new procedures to add to your bag of tricks when doing Bible code searches, over those in
Lesson 1. You can print this lesson in order to go through the numbered steps on your own program at
home. By going through each step, you will learn how to use CodeFinder, applying both the simple
functions and more advanced capabilities. If you haven’t done Lesson 1 yet, please go back and do that
first, since I don’t explain the steps indepth, already explained in Lesson 1.

   When doing name searches in the Bible code, most of the time you enter the last name as the main term
for the search. The Bible code seems to be designed that way. However, sometimes you can look for the
first and last name as one string or term, with no space between them. This is often easiest for people
with short names. In Lesson 2 we will use the name of the current Prime Minister of Israel, Ehud
Barak, as the main search term, written as EhudBarak, but in Hebrew.

   This matrix was first done 60 days prior to the election in Israel in May 1999, when most people still
thought that Benjamin Netanyahu would be re-elected. The matrix topic was on whether Ehud Barak
would win the election? We will look for only 4 terms that were in the matrix, since that is enough to
teach the procedures. The 4 terms are:

EhudBarak--  ÷øáãåäà
(computer keyboard “tvuscre”)

PM (Prime Minister)-- íäø
(computer keyboard “rvo”)
This is the abreviation for a longer title (rosh ha’memshalah) used for the Prime Minister. It is like using
the abbreviation PM in English.

elect, elected-- neevkhar--  øçáð
(computer keyboard “bcjr”)

1999/5759--  èðùúä  and/or  èðùú
(computer keyboard “v,aby” and/or “,aby”)

 Underneath each term in Hebrew, I have given you the letters to type them in on your computer
keyboard. Type them in from left to right, and the Hebrew will be correct from right to left. The top row
of the onscreen Hebrew keyboard corresponds to the top row on your computer keyboard, except that
Israeli qwerty doesn’t use the “Q” and “W” keys. The middle row of the onscreen keyboard corresponds
to the middle row of your computer keyboard; and the bottom row of the onscreen keyboard corresponds
to the bottom row on your computer keyboard. This knowledge will help you learn the Hebrew letters
over time.
  We will enter Ehud Barak as the first term, the main term, to which all other terms are matched. I am
showing both forms of the term for 1999/5759. If we find it with the leading “hey” for the millennium
value, then it is more significant because it has more letters than the everyday shortened year term. With
the leading “hey” it would be 5759 only, while the shorter version for the year stands for both 1999 and
5759.

Step 1. Start the CodeFinder program. Then click on the yellow folder icon button and select the Torah
for search, torah.cod.



Step 2. Open the Settings window under the Options menu. Set Matrix columns and rows to 80 each,
and Wrap Matrix at Skip=20. Lock Matrix should be checked, and Let Search Wrap should be
unchecked. Set 200000 in the Maximum Match Count, and set the Default Minimum Skip= -15000 and
Default Maximum Skip=15000. Press OK to leave Settings.

Step 3. Enter in the Skip: From box -15000 and in the To box 15000.

Step 4. Click in the Search Term pane and open the Onscreen Keyboard using the 3rd button from the
left. Key in Ehud Barak first, so that it will be the main term, as shown above, reading from right to left.
Then type in the terms for PM and elect. Close the keyboard by either pressing the keyboard button or
the little “x” box in the upper right corner of the onscreen keyboard window. Don’t type in the year term,
since we will use the Date Conversion function to do that.
   What if you made a mistake entering a search term, by misspelling it, how do you fix it? If you hit the
Delete button on the main CodeFinder window, it will erase all the terms in your search list (you don’t
want to do that). To delete a single term from the Search List, click on the term you want to delete and
then press the Delete key on your computer keyboard. Then re-enter the term. If it was your main
term, then you need to move it to the top of the list to make it the main term. Open the Search Parameters
window and scroll through all terms until you get to the term you just re-entered, then press the Move To
Top button and the re-entered term will be your main term. Press OK to leave Search Parameters.

Step 5. Under the Tools menu, select Hebrew Date Converter. Use the drop down table to set the
month to May and the year to 1999, which was when the Election in Israel was held. Check the radio
button for DayMonthYear. Check the box that says, Include Millenia in Year. It doesn’t matter what day
of the month is highlighted in the calendar page, since we are only going to enter the year as a term for
search. Locate the pane on the bottom that says Year, and you should see the year term as 5 letters with a
leading “hey” as shown above. Press the Select button next to the Year translation to enter it as a search
term without typing. As it was entered, it went directly into the Search List and the expected occurrences
on the bottom of the screen changed to reflect how many we might expect (627.1). Now uncheck the box
that says Include Millenia in Year. The year term changed to only 4 letters and the leading “hey” was
removed. Press the Select button next to the Year translation to enter for search, and the expected
occurrences are 6999.3. Close the Hebrew Date Converter window, by pressing the Close button.

Step 6. Open the Search Parameters window under the Options menu. Type in Ehud Barak in the
Translation pane for term 1, and then go to term 2 using the up arrow button. For term 2, type in Prime
Minister in the Translation pane. Then check the Ignore in Search box. We are not going to look for PM
in the initial search because it’s only 3 letters long and will be found anywhere. We’ll look for it in a
subsequent search. Go to term 3 using the up arrow button. For term 3 enter “elect” in the Translation
pane. Since the expected occurrences are 29,519, let’s lower the ELS range to lower the expected
occurrences. Uncheck the Use Default Skip Range box and change the Min Skip= -5000 and Max Skip=
5000. The expected occurences should now be 10,362. Go to term 4. Since we used the Hebrew Date
Converter to enter the term, the Translation is already there, but change it to Year 5759/1999. Go to term
5 and change the Translation to Year 5759/1999. Close the Search Parameters window by pressing OK.
Note: the term for Prime Minister is light gray in the Search List, which means it is ignored for search.

Step 7. Before searching, set the row-split to disable by going to OPTIONS--ROW SPLIT--and select
DISABLE. Press the Search button to start the codes search. When done, you should see (12), (10511),
(735), and (7627). It should only take 5-15 seconds to do the entire search, depending the processor
speed of your computer.Open the tree of results for the main term (top one) by clicking on the little +
box. Widen the window so that you can see all the data by moving the cursor to where the matrix area
begins and the cursor changes to 2 vertical lines. Left click and hold down the mouse button and drag to
right to expand the viewing area.

Step 8. Evaluate the results by looking at the number to the far right of each term, in brackets. The
highest number is the matrix we want. Some terms have + boxes next to the book and some don’t, the
ones that don’t have a + box, have no terms matched to them. Two of the finds have [3] matches to the
main term, meaning all four terms are there. They are at the top of the list because CodeFinder version



1.21 sorts the occurrences of the main term by number of matches after the search is complete.
Normally, you would examine both visually to see which looks best. Let’s choose the one with the
lowest ELS value, which is the ELS at -206. Doubleclick on it to display the matrix. Maximize the matrix
display by clicking on the center button in the upper right corner of the matrix window, then move the
main term  to the center of the matrix display in red letters by centering the scroll bars on the bottom and
right side of the matrix window. Open the tree for (5) -206 196277 by clicking on the + box, the matches
are: elect (24), 5759/1999 long (1), 5759/1999 short (6). To toggle these from Hebrew to English, right
click with the mouse somewhere in the white area of the Search List pane.

Step 9. Further evaluate the results by opening the short 5759/1999 term that has 6 matches, we want to
see if the year terms are fairly close to the center term. To re-display the matrix showing just the main
term and one of the short year terms, doubleclick on them one at a time. First double click on -210
196897. We see that it is just below the center term, excellent. Do the others one at a time and see how
close they are to the main term. What you ‘ll find is that 4 of the Year terms are fairly close to the center
term. We can roughly gauge that we can use a smaller matrix to develop, and we’ll use 60x60. Before
changing the rows and columns, we need to see where this matrix is at in the surface scriptures. Move
the matrix scoll bar on the right side all the way to the top and the bottom scroll bar all the way to the
right, then doubleclick on the matrix letter in the upper right corner, that’s the first letter in the matrix. We
see that the letter is in Numbers 1:26, and we Close the Verse Display Window. Next move the scroll bar
on the right all the way to the bottom and the bottom scroll bar all the way to the left, and doubleclick on
the letter in the lower left corner of the matrix, that’s the last letter in the matrix. We see that the Verse
Display tells us it is Numbers 8:26, Close the Verse Display. We have now found the matrix we want to
develop and determined that it runs from Numbers 1:26 to 8:26. Instead of searching the entire Torah,
we will reduce the text Search Area. Close the matrix window by pressing the lower “x” box in the upper
right corner of the screen (DON’T press the very top “x” box or it will quit CodeFinder).

Step 10. First save the Search List so we don’t have to type them all in again, since when we change
the text Search Area, it will erase all results and search terms. Select under the File menu, Export Search
List and name it whatever you’d like, or Barak.stl  Next, select Search Area under the Options menu and
set in Numbers, Chapter 1, Verse 1 in the Start area, and set in Numbers, Chapter 10, Verse 1 in the End
area, and then press OK. It’s good to leave some extra leeway before and after the actual matrix. The
CodeFinder program erases all the work we’ve done so far and changes the text to that we just entered
rather than the entire Torah. Next, select Import Search List under the File menu, click on Barak.stl or
whatever you named it, you should see the name of the file in the File name pane after you highlight the
filename, and click the Open button. The entire Search List loads and has the translation for each one that
we typed in when we went through Search Parameters. Go to the Settings window and set in 60 columns
and 60 rows, and click OK to close the window. Now we can lower the Skip: From value to -1300 and
the To to 1300. We get this value since we know that the matrix we are working on has an ELS of -206.
From experience we know that the limit for vertical terms that are easily readable is about 6 times the ELS
of the matrix, which is a vertical term with a letter on every 6th row.
     Now we go through the Search Parameters again because our entire search area, rows & columns,
and ELS search range have been changed. Term 1 is OK, scroll to term 2. There are too many expected
occurrences, and since this is a 3 letter word, we will only look for horizontal terms in the matrix for
term 2. Uncheck Use Default Skip Range and type in Min Skip= -10 and Max Skip=10. Go to term 3,
and it’s OK, so go to term 4. Term 4 is OK so go to term 5. It’s OK so close the Search Parameters
window by pressing OK.

Step 11. Press the Search button to begin the search. The entire search and terms matching took less
than 2 seconds on my computer. Open the tree for the main term and we see that [4] terms are matched,
meaning all 5 terms are in the new 60x60 matrix. If they weren’t, then we might have to go back to
Settings and change the rows and columns to 70x70 to get them all in the matrix;  it takes less than 2
seconds for the search to complete and to reset everything to the larger matrix. Now we enter a new term
for search within searches, and we will re-enter the 3 letter term for Prime Minister (resh hey mem).
Don’t worry, you can have the same term entered in the Search List more than once, when you want to
set in a different ELS search range. Now enter the same term another time as a new search term. You



should now have 3 PM terms in the Search List. Open Search Parameters again and scroll to the new
term 6. Type in Prime Minister in the Translation pane, uncheck Default Skip Range, and type in Min=
-210 and Max= -202. Go to term 7 and type in Prime Minister and set the Min=202 and Max=210.  We
have to do this if we want to look in a very narrow range for diagonal terms of PM, plus or minus 4 of
the vertical which is 206 (the matrix width). Close Search parameters and press the Search button.
Again, the entire search is less than 2 seconds. Open the tree for Ehud Barak, and we see [6] terms
matched. Open the (1) -206 9894 [6] tree to see how many of each of the 6 are matched, and we see it’s
(24), (6), (1), (4), (14), and (11).

Step 12. All that remains to be done is to turn off the unwanted terms by opening the sub-tree to the
individual occurrences of the matches and right clicking on the unwanted terms to turn them off. It
doesn’t take long if you determine first, the longer terms you want to stay, and leave turned on the other
terms that cross the longer terms or closely parallel them. I started out first deciding what Year terms I
wanted to stay. My optimized matrix had (3), (3), (1), (2), (4), and (3) left turned on, and the area
enclosed in the dashed line box is 32 columns and 40 rows. I read the ELS number for each term right
off the matrix, since I know the matrix width is 206, this skill comes from practice. Reading the number
for each term makes it very quick and easy to know which terms to turn off. There is no right answer,
but you want enough there to make the case, but simple enough to not be overwhelming.

A great function in CodeFinder allows you to directly read the terms in the matrix. Move the cursor
over any marked letter in the matrix, right click and hold down the mouse button. A cursor tooltip
window opens showing the term in both English and Hebrew; it shows an S-value which is the ELS of
that term; and it shows a text R-value which is a Rotenburg statistical calculation to help show whether
the terms are in the matrix by chance or design. Positive R numbers are likely to be there by design,
while short terms have negative R numbers and are likely to be there chance.
    Since this matrix was created to discover a future event before it occurred, be careful about positively
knowing a future event from a simple matrix with only 4 terms. I like to have 10-12 terms minimum to
be much more sure of a future event. Do a couple of these matrixes on the future and keep them to
yourself to see if they come to pass. As you gain more skill and confidence, you will discover that we
can indeed know future events, if we are careful to develop a matrix more thoroughly.

Step 13. Export the Search Results to save your work, by selecting FILE--EXPORT SEARCH
RESULTS. Change the font to Elronet Monospace bold 12 point using the OPTIONS--FONT menu for
use in a graphic for the web. You can display the new matrix Report function by selecting it under View-
-Report, and window between the Report and Matrix View by selecting them under the Window menu.
Save the Report as an RTF file by selecting File--Save Report, then you can modify it later in a word
processing program.

Step 14. Use Cropped Matrix and Save Matrix to save the finished matrix as a graphic BMP file. See
the article in this Tutorial named, Preparing a Matrix and Report for the Web, to learn the procedure for
making your Matrix and Report a very small GIF graphics file for web display.

Optional Step 15: Continue to add more terms to the search list and hit the search button. You can
continually add more terms and quickly develop a more complete matrix, since the program only takes
seconds to add additional terms, complete the search, and match terms. The limit is 500 terms in the
search list. Don’t forget to save your work, using Export Search Results. You can later come back and
Import Search Results on another day and it will load exactly as you quit previously, even saving the
terms you turned off from displaying.  Just pick up where you were when you quit, and develop the
matrix further. My optimized matrix is not shown here, because we want you to do this lesson without
peeking at the final matrix. After all, when you do a matrix on your own, you will not be able to see the
final result before you start. To see the final lesson 2 matrix and matrix report, go to the Codes in the
Bible website, Hebrew Matrixes section, and there is a link near the bottom of the page.
      http://ad2004.com/Biblecodes/Hebrewmatrix/Hebmatrix.html

click here to Return to Tutorial Index



Lesson 3: ADVANCED MATRIX SEARCH USING CODEFINDER
 (August 2000 revision) by Roy A. Reinhold

Note: The topic of Lesson 3 is whether the claims of Yeshua as the real, true, and
genuine Messiah are correct. If this will offend you, then don’t do the lesson.

Using the advanced functions in CodeFinder version 1.21, we will do an initial search using
“Yeshua ben-El”, which means Jesus, Son of God, as the center or main term on which the matrix
pivots. The other terms in the initial search are taken from the prophecy in Isaiah 9:5 (9:6 in the
English Bible), which reads as follows:

Isaiah 9:5  For unto us a child is born, to us a son is given; and the government is upon his
shoulder; and his name shall be called  “Wonderful counselor of the mighty God, of the Prince of
Peace”.    (from recent rabbinical translation to English).

Isaiah 9.6 (NASB English Bible)  For a child will be born to us , a son will be given to us; and the
government will rest on His shoulders; and His name will be called Wonderful Counselor, Mighty
God, Eternal Father, Prince of Peace.

You can see that the main thoughts in the two translations are slightly different. However,
they are in common in speaking of the Messiah. The following lesson will introduce a number of
new concerns when using CodeFinder.

The purpose of the matrix is to determine whether or not  all the names in Isaiah 9:5 apply to
Yeshua ben-El as the Messiah. We will also add other terms later that support our findings.

Step 1:   Start the CodeFinder program and select the button on the far left that has a yellow folder
on it, in order to open the text file. Highlight the “torah.cod” filename and hit the Open button.
This will load the Torah as the text to search. You could also have used the menus by selecting
FILE--OPEN.

Step 2:   Open the SETTINGS window by going to the menus and selecting Options--Settings.
Make the following settings:

Max Match Count -- 500,000  (don’t use a comma)
Default Minimum Skip --  -65,000 (don’t use a comma, and this is a negative number)
Default Maximum Skip --  65,000  (don’t use a comma)
Matrix Columns --   200
Matrix Rows --  200
Wrap Matrix at Skip --  20

        Checked box --  Lock Matrix
Unchecked box --  Let Search Wrap

Close the Settings window by pressing the OK button. You should know this procedure, since it is
true for all Windows programs on the PC. If you make changes in a Settings window and exit by
closing it using Cancel or by the little “x” button in the upper right corner of the window, then it
exits without saving the changes you made in Settings. You have to exit using the OK button.

Step 3:   Next to the Search button, enter Skip: From   -65000 and To  65000
It is minus 65,000 to plus 65,000 so that the program will look for both forward and reverse
occurrences of the search terms.

Step 4:   Now we are ready to enter the search terms. You can use either the onscreen Hebrew
keyboard or your computer keyboard. After the terms below in Hebrew, I have put the terms as
you would type them using the English letter legends on your computer keyboard, going from left
to right. This will enter them properly in Hebrew from right to left in CodeFinder. The top row of



letters in the onscreen keyboard correspond to the top row of letters on your computer keyboard
(except that Hebrew doesn’t use the “Q” and “W” keys in standard Israeli qwerty. The middle row
of the onscreen keyboard is the same as using the middle row on your computer keyboard, and the
bottom row of the onscreen keyboard is the same as the bottom row on your computer keyboard.

Type in the 6 terms in the following order:

Jesus, Son of God -- Yeshua ben-El --   ìàðáòåùé
computer keyboard “haugcitk”

Wonderful, He Counsels -- pele ya’atz --   õòéàìô
computer keyboard “pkthg.”

Mighty God -- El geebor --   øåáâìà
computer keyboard “tkdcur”

Eternal Father -- abee’ad --   ãòéáà
computer keyboard “tchgs”

Prince of Peace -- sar shalom --   íåìùøù
computer keyboard “arakuo”

the Messiah -- ha’mashiach --   çéùîä
computer keyboard “vnahj”

Note: The Hebrew end letters show up as normal Hebrew letters in the CodeFinder search term
entry windowpane. For example, the “nun sofit” of “ben” in term one uses the regular “nun”,
because in all Bible code programs, the end letter equals the regular letter for codes purposes. And
here, nun sofit=nun. Likewise in the second term tzadik sofit=tzadik. In the 5th term, mem
sofit=mem.  Also, note that for term 2 above, the last letter is the English period key, that’s where
“tzadik sofit” is at on the keyboard.

OK, that wasn’t so hard after all, typing in the Hebrew letters.

Step 5:   The next step is to go to Search Parameters window under the Options menu. As we go
through each term, you want to do 2 things, one is to type in the English translation (leaving none
of those dashes), and the second is to make sure that at the bottom bar of the Search Parameters
window, the real-time statistics show that we are not going to have too many finds. That can
happen when you look for 3 or 4 letter words.

For the first term, type in “Yeshua, Son of God” or “Jesus, Son of God” in the translation
pane. Then we check and see that we expect 6 occurrences, that’s OK, so we go to term 2 using
the small up arrow button. We type in “Wonderful, He Counsels” and see that we expect 97
occurrences, so we go to term 3. We type in “Mighty God” and see that we expect 275
occurrences, so we go to term 4. We type in “Eternal Father” and see that we expect 9529
occurrences, that’s OK, so we go to term 5. We type in “Prince of Peace” and see that we have
1798 occurrences, that’s OK, so we go to term 6. We type in “the Messiah” and see that we expect
21,493 occurrences. Normally, I would lower that so I don’t get more than about 12,000 of any
one term. But in this case, we’ll leave it. We can always go back and search again and lower the
ELS range for just this one term. We lower the expected occurrences by unchecking the “Use



Default Skip Range” box and typing in a lower Min--Max Skip Range. Press the OK button and
leave the Search Parameters window.

Step 6:   Hit the Search button to begin the search. On my computer with an AMD K6-2
processor running at 475 mhz and using CodeFinder version 1.21, it only takes 37 seconds to look
for all 6 terms and match the terms.

Step 7:   The results show as follows:
term 1 -- Yeshua ben-El --  3
term 2 -- Wonderful, He Counsels -- 101
term 3 -- Mighty God -- 241
term 4 -- Eternal Father -- 9529
term 5 -- Prince of Peace -- 1699
term 6 -- the Messiah -- 22,239

Step 8:   The next step is to analyze the results by looking at the 3 occurrences of Yeshua ben-El
and see if all 5 of the other terms are matched to any one of the 3. We click on the little plus box
next to the first term, and it shows the following: (note: we have the row-split set to disable)
     (1)  10205     199650  [1]
     (2)  -15309    249576  [1]
     (1)  -25897    205945

Our initial results show the above, which means that only one other term is matched to the
main term with row-split disabled. The 1st number in brackets is a sequential number, the 2nd
number is the ELS, the 3rd number is the letter number of the first letter in the term, and the
important 4th number in square brackets is the number of terms matched to the main term. If you
cannot see all the results at once in the Search Results pane without scrolling, move the cursor over
to where the matrix area begins, and the cursor changes from an arrow, to 2 vertical lines with a
right and left arrow. Left-click and hold down the mouse button, and drag to the right, so that the
Search Results area is wide enough to read all the information. CodeFinder version 1.21 sorts the
occurrences of the main term after the search so that the highest matches are at the top of the list,
then sorts so that the lower ELS is higher if there are more than 1 occurrence of the main term with
the same number of matches.

If you received a different number of matches, then your row-split setting was not on disable.
Go to the Options--Row Split and set it on disable and see if the results are as above. The good
thing is that we found 3 occurrences of Yeshua ben-El in the Torah.

Now we will use the Row-Split “auto” function. What “auto” row-split does is the same as a
“find best matrix” function. It will look at all 11 row-split settings for each occurrence of the main
term, and then show the highest number of matches for each one of the 3 occurrences of the main
term based on the best row-split for each. Go ahead and select Options--Row-Split--auto. Now the
first occurrence has 5 matches, the 2nd occurrence has 4 matches, and the 3rd occurrence has 3
matches. So we have found the matrix that has all 6 terms in it, at an initial ELS of 10205, but
row-split to an unknown amount.

Double-click on the (1) 10205 line and the matrix will pop up. In the upper right corner of the
Matrix View, click the center little box to expand the matrix and fill the matrix area on the screen.
You can narrow the Search Results area by moving the cursor to where the matrix starts and the
cursor changes to 2 vertical lines, left click and hold it down and drag left. This will give you more
matrix area to view at once. Center the scroll bars on the right and bottom of the matrix to center
the matrix, since we want to view the center term and see what the optimal row split is at.

The center term in CodeFinder is always red letters in a black oval. We see that the center term
has letters every 4th line, so the optimal row-split is 4. Our initial ELS was 10205, but since we
row-split by 4, our optimal matrix is at an ELS of 10205÷4=2251. We also see that our
center term is slightly diagonal with each letter going down displaced by 1 column to the left. A
term doesn’t need to be evenly divisible for a row-split to occur.



Move your cursor on top of one of the letters for Yeshua ben-El and right click, holding down
the mouse button. The window will open showing the term in English and Hebrew, it shows the
ELS of the term, and a statistical text “R” value. R is for Rotenburg, and CodeFinder calculates R
by taking the inverse of the expected number of occurrences calculation and puts it on a log10
scale. Negative text R-values are likely there by chance, while positive R numbers are likely to be
there by design. (short words have negative R numbers, and longer terms have positive R
numbers). The text R-value is helpful, but it is not an absolute measure of chance or design. You
can right-click and hold the mouse button down on any marked letter in the matrix, and it will
show similar information. Except for the main/center term, we are interested in what the matrix R-
value is for all other terms, which is calculated for expectation that the term would appear in this
matrix (matrix R-values are shown in the matrix report).

Step 9:   The next step is to analyze the matrix and turn off extra terms, leaving the best ones there
and also making the matrix size smaller than our original 200 rows and 200 columns.

The new version 1.21 of CodeFinder no longer wraps the matrix to fill it to
the size in rows and columns settings. Version 1.21 gives the user a set of
training wheels. The matrix area is still 200x200 in our example, but the extra
rows are now blanked and shown as white space, where before they were
wrapped inadvertently. The new change in version 1.21 will prevent users from
using erroneous rows that were wrapped.
       We open the tree of results for the 3rd occurrence of Yeshua ben-El at:
          (1)  10205  199650  [5]

by clicking on the plus box next to it. We see that the terms are matched as follows (in English,
you can toggle them to English by right clicking anywhere in the white space of the Search List.
Another way to toggle to English or back to Hebrew is the menu selection, Options--View as
English ):

Wonderful, He Counsels [1]
Mighty God  [1]
Eternal Father  [13]
Prince of Peace  [5]
the Messiah  [45]

      Our next step is to turn off terms so that we can make that dotted line box as small as possible
when displaying the matrix with all the terms, and certainly within the valid region for the matrix.
After turning off extra terms, my optimal matrix was 156 columns and 106 rows. I left
turned on for each of the 5 terms:   1, 1, 4, 2, & 8 respectively.

I left turned on more of the term “ha’mashiach” meaning “the Messiah”, because I planned on
further developing the matrix, and it seems to be an important term with regard to our central term
of Yeshua ben-El, Jesus, Son of God.

Step 10:   We’ve developed a matrix with 6 terms that are significant. The center term is Yeshua
ben-El meaning Jesus, Son of God. Then we see all the other terms from the prophecy of names of
the Messiah in the same matrix. We can go much further, by adding in other terms like Savior,
Redeemer, Righteous one, true one, genuine one, changeless one, visible one, Almighty, etc. All
in all, there are at least 30 more terms in the matrix that I’ve already found. I will give them to you
below, but the point is that this matrix is but one of many that proves clearly in the Bible code that
Yeshua is the promised Messiah. He came once and He’s coming again very soon.

When you develop a more complex matrix like this, you want to get the major terms first, then
add in other terms. CodeFinder facilitates this by retaining the work you’ve already done, and only
looking for the new terms you add. With a couple of hours work adding the terms below, you can
have a matrix that has more than anyone else has on the web on this subject. I haven’t put this
matrix up on the web, because I developed it especially for this lesson. The other two occurrences



of Yeshua ben-El that we didn’t explore from our initial search are very meaningful too, they are
just on different topical aspects of the Messiah.

Step 11: Display the matrix Report that shows all the terms in your matrix, by selecting View--
Report. You can window between the Matrix View and Report by selecting them under the
Window menu. Save the Report as an RTF file by selecting File--Save Report.

Step 12: (optional)   Below are terms that you can add to the matrix. They are all there, so have
fun. When you get it completed, make sure you save your matrix by Exporting Search Results. To
directly save your finished matrix with all the terms as a graphic when you’re done, use Cropped
Matrix, and then Save Matrix to save it as a BMP graphics file. Then you can open it in a graphics
program and save it as a GIF for display on the web. If you do a good job, we’ll put it up on the
Codes in the Bible website with attribution at:
     Codes in the Bible     http://ad2004.com/Biblecodes/indexA.html

    Optional terms to look for are:     (in the center are the English letters to type in the Hebrew
terms on your computer keyboard). Just an added note. When you search for these optional terms,
since we know the matrix is at an ELS of 2251, don’t search our original ELS range of -65,000 to
65,000. The maximum you’ll want to search will be 6 times the matrix ELS plus 10, or -13,520 to
13,520. Customize the ELS range for each term using Search Parameters, to lower the expected
occurrences to a reasonable number. (like 10,000 or less for each term).
Messiah-- nahj --   çéùî
real one-- nnah --   éùîî
true, genuine one-- tnh,h --   éúéîà
righteous one-- har --   øùé
Justice-- mse --  ÷ãö
Truth-- tn, --  úîà
the right one-- hnhi -- ïéîé
Savior, Redeemer-- dutk --  ìàåâ
verily, certain-- tfi --  ïëà
Torah-- ,urv --   äøåú
maker, creator-- curt --   àøåá
revelation, descent-- numt --   àöåî
appearance-- nrtv --   äàøî
visible-- brtv --   äàøð
arrive-- kcut --   àåáì
descent-- krs, --   úãøì
correct, right one-- bfui --   ïåëð
Savior-- nmhk --   ìéöî
counselor-- hug. --   õòåé
Almighty-- ntus --   ãåàî
awe-- nurt --   àøåî
manifest-- nbar --   øùðî



changeless-- hmhc --  áéöé
Bible-- nert --   àø÷î
heaven-- anho --   íéîù
I Am-- tvhv --   äéäà
Yahveh-- hvuv --   äåäé
Yeshua-- haug --   òåùé

click here to Return to Tutorial Index


